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Paper Set 1 · 13 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Two pipes, A and B, can fill a tank in 12 hours and 15 hours,
respectively. Another pipe, C, can empty the tank in 20 hours. If all
the pipes are opened together, in how long will the tank be filled?

A.  8 hours

B.  10 hours

C.  9 hours

D.  12 hours

✓

Q2 Quant
Shalini has to purchase a microwave. The microwave is available at a
discount of 20% and an additional festival discount of 5%. If the
marked price of the microwave is ₹7,000, then what is the selling
price of the microwave?

A.  ₹5,330

B.  ₹5,340

C.  ₹5,320

D.  ₹5,350

✓

Q3 Quant
The ratio of two numbers is 3 : 5, and their sum is 64. What are the
two numbers?

A.  20 and 44

B.  24 and 40

C.  18 and 46

D.  22 and 42

✓

Q4 Quant
A train runs at a speed of 72 km/hr. How much distance will it cover
in 25 minutes?

A.  30 km

B.  40 km

C.  24 km

D.  28 km

✓

Q5 Quant

The volume of a cone is 9,856 cm3, and its height is 24 cm. If the
radius is increased by 25% and the height is decreased by 20%, what
will be the percentage change in volume?
[Use π = 22/7]

A.  20% decrease

B.  24% increase

C.  25% increase

D.  28% decrease

✓

Q6 Quant
Find the arithmetic mean of the following data.
Class interval 0-8 8-16 16-24 24-32

Frequency 2 1 4 3

A.  14.8

B.  16.3

C.  17.7

D.  18.4

✓

Q7 Quant
Ravi, Rishi and Vaibhav start a business with ₹62,000. Ravi,
subscribes ₹5,000 more than Rishi and Rishi ₹6,000 more than
Vaibhav. Out of a total profit of ₹31,000, Ravi receives:

A.  ₹14,000

B.  ₹13,000

C.  ₹15,000

D.  ₹16,000

✓

Q8 Quant
By how much is 30% of 65 greater than 25% of 30?

A.  12

B.  7

C.  9

D.  14
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✓

Q9 Quant
Three numbers are in the ratio 3 : 11 : 2, and their LCM is 7590. Their
HCF is:8577

A.  115

B.  153

C.  96

D.  100

✓

Q10 Quant
A sum of ₹5,432 is divided into three parts such that half of the first
part, one-fourth of the second part, and one-eighth of the third part
are equal. What is the positive difference (in ₹) between the first and
the second parts?

A.  776

B.  676

C.  926

D.  626

✓

Q11 Quant
The profit made on a product is 59%. What is the loss percentage
(correct to two decimal place) incurred on the sale if the figures of
both cost price and selling price are interchanged?3173

A.  37.11%

B.  39.10%

C.  36.58%

D.  38.53%

✓

Q12 Quant
What will be the amount after 1 year, if ₹4700 is invested at 20%
compound interest per annum, compounded half-yearly?9797

A.  ₹5687

B.  ₹5228

C.  ₹5597

D.  ₹6114

✓

Q13 Quant
The line intersecting any circle at exactly one point is called a:

A.  Secant

B.  Tangent

C.  Chord

D.  Diameter

✓

Q14 Quant
The radius of a cone is 18 cm and its height is 24 cm. The total
surface area (in cm2) of the cone is: (Use π = 22/7, and round off
your answer to the nearest integer)

A.  2715

B.  1247

C.  3027

D.  2118

✓

Q15 Quant
In what time (in months) will ₹3300 fetch an interest of ₹440 at 8%
per year simple interest?

A.  20

B.  17

C.  18

D.  24

✓

Q16 Quant
A number when increased by 60%, gives 3470. The number is:

A.  2168.75

B.  2337.5

C.  1084.37

D.  1506.25

✓

Q17 Quant
The pipes P and Q together can completely fill an empty cistern with
water in 8 hours. If P alone can fill the cistern with water in 40 hours,
in how many hours will Q alone fill half of the cistern with water?

A.  5

B.  10

C.  6

D.  11
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✓

Q18 Quant

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Who set a world record in the men’s javelin F42 category at the
Nottwil World Para Athletics Grand Prix in Switzerland?

A.  Mahendra Gurjar

B.  Sumit Antil

C.  Neeraj Chopra

D.  Devendra Jhajharia

✓

Q22 GA
Who among the following becomes the first Indian to throw over
90 m internationally in javelin in May 2025?

A.  Neeraj Chopra

B.  Shivpal Singh

C.  DP Manu

D.  Kishore Jena

✓

Q23 GA
Which organisation conducted the Coastal Vulnerability Index (CVI)
study for Odisha on climate change?

A.  National Institute of Oceanography (NIO)

B.  Indian National Centre for Ocean Information Services
(INCOIS)

C.  Ministry of Earth Sciences (MoES)

D.  National Centre for Coastal Research (NCCR)

✓

Q24 GA
In which of the following States did The Paika Rebellion (1817), a
powerful armed revolt against the British, take place?

A.  Bihar

B.  Maharashtra

C.  Odisha

D.  Assam

✓

Q25 GA
Which gram panchayat in Odisha won the jury award at the National
Awards for e-Governance (NAeG) 2025 announced in September
2025, for its innovative use of technology to enhance governance
and service delivery at the grassroots level?

A.  Palsana

B.  Rohini

C.  Suakati

D.  West Majlishpur

✓

Q26 GA
The Shanghai Cooperation Organization (SCO) held its 25th Heads-
of-State Council summit in August–September 2025. In which city
did this summit take place?

A.  Beijing

B.  Astana

C.  Tianjin

D.  Samarkand

✓

Q27 GA
Which of the following sand art festivals was organized at
Chandrabhaga Beach in December 2025?

A.  Konark International Sand Art Festival

B.  Puri Sand Art Festival

C.  Gopalpur Sand Art Festival

D.  Rann Utsav

✓

Q28 GA
Which river system forms the largest delta in India before draining
into the Bay of Bengal?

A.  The Ganga-Brahmaputra River System

B.  The Mahanadi River System

C.  The Krishna River System

D.  The Godavari River System

✓

Q29 GA
What was the primary outcome of the United Nations Conference
on Human Environment regarding international organizations'
responsibilities?

A.  International organizations were compelled to address
global environmental problems

B.  International organizations reduced their involvement in
environmental matters

C.  International organizations were limited to regional
environmental issues

D.  International organizations shifted focus to economic
development
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✓

Q30 GA
If a child’s pituitary gland malfunctions, which of the following
hormones may be affected, leading to growth issues?

A.  Adrenaline

B.  Thyroxine

C.  Insulin

D.  Growth hormone

✓

Q31 GA
A student adds magnesium ribbon to a solution of silver nitrate.
What is the expected result?

A.  Magnesium forms magnesium oxide

B.  No reaction occurs between magnesium and silver nitrate

C.  Magnesium replaces silver and forms magnesium nitrate

D.  Silver magnesium nitrate is formed

✓

Q32 GA

An object experiences a gravitational acceleration of 10 m/s2 on
Earth and 2 m/s2 on the Moon. If its weight on Earth is 60 N, what
will be its weight on the Moon?

A.  6 N

B.  10 N

C.  12 N

D.  15 N

✓

Q33 GA
Which type of volcano is most likely to produce highly explosive
eruptions due to viscous magma?

A.  Shield volcano

B.  Composite volcano

C.  Rift volcano

D.  Flood basalt plateau

✓

Q34 GA
Which of the following is a type of folk music from Rajasthan?

A.  Bihu

B.  Lavani

C.  Maand

D.  Baul

✓

Q35 GA
Which of the following plateaus is known for its rich reserves of iron
and coal?

A.  Deccan Plateau

B.  Chhota Nagpur Plateau

C.  Malwa Plateau

D.  Karnataka Plateau

✓

Q36 GA
What was the rank of India in the Gender Inequality Index (GII)
2022?

A.  110

B.  115

C.  108

D.  125

✓

Q37 GA

Which of the following Directive Principles was added by the 42nd

Constitutional Amendment Act, 1976?

A.  Promotion of international peace and security

B.  Uniform Civil Code for the citizens

C.  Protection and improvement of the environment

D.  Equal pay for equal work for both men and women

✓

Q38 GA
In which of the following places in Odisha did Mahima Dharma
reveal himself in 1826?

A.  Bhadrak

B.  Cuttack

C.  Bhubaneswar

D.  Puri
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✓

Q39 GA
Which prestigious award did Ustad Bismillah Khan receive in 2001?

A.  Padma Shri

B.  Padma Bhushan

C.  Bharat Ratna

D.  Padma Vibhushan

✓

Q40 GA
What is the name of the fund that UNICEF India has launched to
support tech-driven child protection solutions in 2025?

A.  Child Safety Innovation Grant

B.  Child Protection Innovation Fund

C.  Innovation Fund for Youth

D.  UNICEF India Digital Safety Fund

English

✓

Q41 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The robbers are searching for a place to hide the things.

A.  claque

B.  cache

C.  cortege

D.  connoisseur

✓

Q42 English
Select the most appropriate adverb to fill in the blank.

I _____ visit the war memorial, where sleeps my old friend Joe.

A.  often

B.  early

C.  now

D.  wildly

✓

Q43 English
Select the most appropriate proverb that can substitute the highlighted segment in the given sentence.

Don't open that unverified link because being too inquisitive risks trouble.

A.  the cat is out of the bag

B.  the ball is in your court

C.  curiosity killed the cat

D.  it's not rocket science
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✓

Q44 English
Choose the correct idiom to substitute the underlined word segment in the following sentence.
When the manager saw the unfinished report, he became very angry suddenly.

A.  kept his cool

B.  turned a blind eye

C.  blew his top

D.  made ends meet

✓

Q45 English
Which among the following sentences uses the correct form of the future tense?

A.  At this time tomorrow, we will walks in the hills.

B.  At this time tomorrow, we will walked in the hills.

C.  At this time tomorrow, we will be walking in the hills.

D.  At this time tomorrow, we will walking in the hills.

✓

Q46 English
Select the most appropriate antonym of the underlined word in the given sentence.
He is very crafty.

A.  heartless

B.  graceful

C.  virtuous

D.  unskilled

✓

Q47 English
Identify the INCORRECTLY spelt word in the given sentence and select the option that rectifies it.

The student's inquissitive nature led her to ask many probing questions about the scientific principle, making the class discussion far more
engaging.

A.  probbing

B.  principel

C.  inquisitive

D.  discusion

✓

Q48 English
Select the sentence that is correctly written in the active voice.

A.  The guests were being served dinner by the host.

B.  Dinner had been served before the guests arrived.

C.  The host served dinner to the guests.

D.  The dinner was served by the host to the guests.
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✓

Q49 English

Read the given passage carefully and answer the questions that follow.

Every person has the same twenty-four hours in a day, but how we use them makes all the difference. Time is one of the most valuable resources
in life, and how we use it determines our success and happiness. Time management is the practice of organizing and planning how to divide
time between tasks effectively. Good time management increases productivity, reduces stress, and ensures that important activities are
completed on time. Students, professionals, and everyone can benefit from prioritizing tasks, setting goals, and avoiding procrastination. Poor
time management can lead to missed deadlines, poor performance, and increased pressure. Using tools like planners, schedules, and digital
reminders can help manage time efficiently. By valuing time and organizing activities wisely, individuals can achieve their goals, balance work
and leisure, and lead a more disciplined and fulfilling life. Therefore, learning and practicing time management daily can lead to greater success,
peace of mind, and a well-balanced future.

According to the passage, what are some tools that can help people manage their time efficiently?

A.  Clocks and alarms

B.  Planners and digital reminders

C.  Books and magazines

D.  Charts and graphs

✓

Q50 English
What is the main theme of the passage?

A.  The importance and benefits of managing time effectively

B.  The problems caused by digital distractions

C.  The relationship between time and technology

D.  The need for rest and relaxation in daily life

✓

Q51 English
Which of the following titles best fits the passage?

A.  The Dangers of Procrastination

B.  Time: The Key to Success

C.  Learning the Value of Patience

D.  Balancing Work and Play

✓

Q52 English
Which statement best describes the structure of the passage?

A.  Time management: definitions, benefits, consequences, and tools

B.  It lists examples of successful people who use planners.

C.  It describes different types of clocks and calendars.

D.  It compares time management with money management.
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✓

Q53 English
Choose the antonym of the word “productivity” as used in the passage.

A.  Efficiency

B.  Laziness

C.  Improvement

D.  Success

✓

Q54 English
Words of a sentence are given below in jumbled order. Arrange the words in the correct order to form a meaningful sentence.

under/ now /law,/ violence /domestic / is /crime/a /the/punishable/enacted /newly/as/recognised

A.  Newly under as the enacted law, domestic violence is now recognised a punishable crime.

B.  Under the newly enacted law, domestic violence is now recognised as a punishable crime.

C.  The newly recognised domestic violence under law, is now enacted as a punishable crime.

D.  Under the newly enacted law, is domestic violence recognised now as a punishable crime.

✓

Q55 English
Choose the incorrect indirect speech sentence.

A.  The professor explained that the exam would begin at nine o’clock.

B.  The professor explained that the exam began at nine o’clock.

C.  The professor explained that the exam begins at nine o’clock.

D.  The professor explained that the exam was scheduled for nine o’clock.

✓

Q56 English
A statement divided into different segments is given. Rearrange all the segments to form a coherent statement.

(A) the green park, chasing a yellow
(B) ball while children laughed and
(C) the small dog ran across
(D) parents watched from nearby benches

A.  CABD

B.  ABCD

C.  DCBA

D.  BDCA

✓

Q57 English
Select the most appropriate antonym of the highlighted word in the sentence:

The factory’s output was consistent over the last year.

A.  irregular

B.  stable

C.  abundant

D.  profitable
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✓

Q58 English
Select the option that can be used as a one-word substitute for the given group of words.

A government ruled by a single person

A.  Democracy

B.  Monarchy

C.  Oligarchy

D.  Theocracy

✓

Q59 English
Select the most appropriate option to fill in the blank.

___ Himalayas are known for their majestic peaks and spiritual significance.

A.  A

B.  An

C.  The

D.  That

✓

Q60 English
Complete the sentence with a contextually and grammatically appropriate preposition.

He travelled _______ the river by boat to reach the other side.3641

A.  across

B.  over

C.  along

D.  against

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ଦୋକାନକୁ  କ୍ଷୀର ଆଣି ବାକୁ  ଗଲେ ।

A.  She went to the shop to buy milk.

B.  She go to shop for buying milk.

C.  She was gone in shop for milk.

D.  She went shop to buy a milks.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The Himalayas protect India from cold northern winds.

A.  ହି ମାଳୟ ପର୍ବ ତମାଳା ଭାରତକୁ  ଶୀତଳ ଉତ୍ତରୀୟ ବାୟୁ ଠାରୁ  ରକ୍ଷା କରି ଥାଏ।

B.  ହି ମାଲୟ ଉତ୍ତର ପବନ ଶୀତରୁ  ଭାରତ ସୁ ରକ୍ଷା କରନ୍ତି ।

C.  ହି ମାଲୟ ଉତ୍ତର ପବନ ଶୀତ ଭାରତକୁ  ସୁ ରକ୍ଷା କରେ।

D.  ହି ମାଲୟ ଉତ୍ତର ପବନ ଶୀତରୁ  ଭାରତକୁ  ସୁ ରକ୍ଷି ତ କରନ୍ତି ।
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✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Planting trees helps in balancing oxygen and carbon dioxide levels.

A.  ବୃ କ୍ଷରୋପଣ ଅମ୍ଳ ଜାନ ଏବଂ ଅଙ୍ଗାରକାମ୍ଳ  ସ୍ତରକୁ  ସନ୍ତୁଳନ କରି ବାରେ ସାହାଯ୍ୟ କରେ।

B.  ଗଛ ଲଗାଇବା ଅକ୍ସି ଜେନ ଓ କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ ସନ୍ତୁଳନ କରି ଲା।

C.  ଗଛ ଲଗାଇବା ଅକ୍ସି ଜେନ ଓ କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ ସନ୍ତୁଳନ ହେଲା।

D.  ଗଛ ଲଗାଇବା ଅକ୍ସି ଜେନ ଓ କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ ସନ୍ତୁଳନ କରେ।

✓

Q64 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଆନନ

A.  ହସ୍ତ

B.  ମୁ ଖ

C.  ବଦନ

D.  ବକ୍ଷ

✓

Q65 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ବି ଭବ

A.  ମାଲି କ

B.  ରାଜା

C.  ସମ୍ପଦ

D.  ସମ୍ରା ଟ

✓

Q66 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

ଭାରତୀୟ ନାଗରି କଙ୍କ ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ସମ୍ବି ଧାନର ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶ, ଯାହା ଜାତୀୟ ଏକତା, ଅଖଣ୍ଡତା ଏବଂ ଗଣତାନ୍ତ୍ରି କ ମୂ ଲ୍ୟବୋଧକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା ପାଇଁ  ପ୍ର ତ୍ୟେକ ନାଗରି କଙ୍କ ପାଳନ
କରି ବାକୁ  ଥି ବା ନୈ ତି କ ଦାୟି ତ୍ବ  ଏବଂ ଦାୟି ତ୍ୱକୁ  ଉଜାଗର କରି ଥାଏ। ସର୍ଦ୍ଦା ର ସ୍ୱରଣ ସିଂ  କମି ଟି ର ସୁ ପାରି ଶକ୍ର ମେ, 1976 ମସି ହାରେ 42ତମ ସମ୍ବି ଧାନ ସଂଶୋଧନ ଆଇନ ଦ୍ୱାରା ପ୍ର ବର୍ତ୍ତିତ, ଏହି
କର୍ତ୍ତ ବ୍ୟ ଗୁ ଡ଼ି କୁ  ଅନୁ ଚ୍ଛେଦ 51A ଅଧୀନରେ ଭାଗ IV-A ରେ ଅନ୍ତର୍ଭୁ କ୍ତ କରାଯାଇଥି ଲା। ମୂ ଳତଃ, ଦଶଟି  କର୍ତ୍ତ ବ୍ୟ ଥି ଲା, କି ନ୍ତୁ 86 ତମ ସମ୍ବି ଧାନ ସଂଶୋଧନ ଆଇନ, 2002 ଏକାଦଶ କର୍ତ୍ତ ବ୍ୟ
ଯୋଡ଼ାଯାଇଥି ଲା, ଯେଉଁ ଥି ରେ 6 ରୁ  14 ବର୍ଷ  ବୟସର ପି ଲାମାନଙ୍କୁ  ଶି କ୍ଷାର ସୁ ଯୋଗ ପ୍ର ଦାନ କରି ବା ପାଇଁ  ପି ତାମାତା କି ମ୍ବା ଅଭି ଭାବକଙ୍କ ଦାୟି ତ୍ୱ ବୋଲି  ଦର୍ଶ ଯାଇଛି  । ମୌଳି କ ଅଧି କାର
ନାଗରି କମାନଙ୍କୁ  ସ୍ୱାଧୀନତା ଏବଂ ସୁ ରକ୍ଷା ପ୍ର ଦାନ କରେ । ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ମୌଳି କ ଅଧି କାର ପରି  ନୁ ହେଁ  ବରଂ ଏହା ଦାୟି ତ୍ୱପୂ ର୍ଣ୍ଣ  ନାଗରି କତା ପାଇଁ  ମାର୍ଗ ଦର୍ଶିକା ଭାବରେ କାର୍ଯ୍ୟ  କରେ,
ବ୍ୟକ୍ତି ମାନଙ୍କୁ  ସମ୍ବି ଧାନକୁ  ସମ୍ମାନ କରି ବା, ଗଣତାନ୍ତ୍ରି କ ମୂ ଲ୍ୟବୋଧକୁ  ଅନୁ ସରଣ କରି ବା ଏବଂ ସମାଜରେ ସକାରାତ୍ମକ ଅବଦାନ ଦେବା ପାଇଁ  ମଧ୍ୟ ଉତ୍ସାହି ତ କରେ।

କର୍ତ୍ତ ବ୍ୟ ମଧ୍ୟରେ ସମ୍ବି ଧାନ, ଜାତୀୟ ପତାକା ଏବଂ ଜାତୀୟ ସଙ୍ଗୀତକୁ  ସମ୍ମାନ କରି ବା; ସ୍ୱାଧୀନତା ସଂଗ୍ରା ମକୁ  ପ୍ରେ ରଣା ଦେଇଥି ବା ମହାନ ଆଦର୍ଶ କୁ  ପାଳନ କରି ବା ଏବଂ ଅନୁ ସରଣ କରି ବା;
ଭାରତର ସାର୍ବ ଭୌମତ୍ୱ, ଏକତା ଏବଂ ଅଖଣ୍ଡତାକୁ  ରକ୍ଷା କରି ବା; ଦେଶକୁ  ରକ୍ଷା କରି ବା ଏବଂ ଆହ୍ୱାନ ସମୟରେ ଜାତୀୟ ସେବା ପ୍ର ଦାନ କରି ବା; ସମନ୍ୱ ୟ ଏବଂ ସାଧାରଣ ଭ୍ରା ତୃ ତ୍ୱର ଭାବନାକୁ
ପ୍ରୋ ତ୍ସାହି ତ କରି ବା; ମହି ଳାମାନଙ୍କ ସମ୍ମାନ ପ୍ର ତି  ଅପମାନଜନକ ଅଭ୍ୟାସଗୁ ଡ଼ି କୁ  ପରି ତ୍ୟାଗ କରି ବା; ଭାରତର ସମୃ ଦ୍ଧ ସଂସ୍କୃତି ର ସମୃ ଦ୍ଧ ଐତି ହ୍ୟକୁ  ସଂରକ୍ଷଣ କରି ବା; ଜଙ୍ଗଲ, ହ୍ର ଦ, ନଦୀ ଏବଂ
ବନ୍ୟପ୍ରା ଣୀ ସମେତ ପ୍ରା କୃ ତି କ ପରି ବେଶକୁ  ସୁ ରକ୍ଷା ଏବଂ ଉନ୍ନତି  କରି ବା; ବୈ ଜ୍ଞାନି କ ମନୋଭାବ, ମାନବବାଦ ଏବଂ ଅନୁ ସନ୍ଧାନ ଏବଂ ସଂସ୍କାରର ଭାବନା ବି କାଶ କରି ବା; ସାର୍ବ ଜନୀନ ସମ୍ପତ୍ତି କୁ  ସୁ ରକ୍ଷା
ଦେବା; ଏବଂ କାର୍ଯ୍ୟ କଳାପର ସମସ୍ତ କ୍ଷେତ୍ର ରେ ଉତ୍କର୍ଷ ତା ପାଇଁ  ପ୍ର ୟାସ କରି ବା ଆଦି  ରହି ଛି  । ଯଦି ଓ ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ଗୁ ଡ଼ି କ ନ୍ୟାୟ ବି ଚାରଯୋଗ୍ୟ ନୁ ହେଁ , ଅର୍ଥା ତ୍  ସେଗୁ ଡ଼ି କୁ  କୋର୍ଟ  ଦ୍ୱାରା ଲାଗୁ
କରାଯାଇପାରି ବ ନାହିଁ, ତଥାପି  ଏଗୁ ଡି କ ନାଗରି କମାନଙ୍କୁ  ମନେ ପକାଇବାରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରେ ଯେ ଅଧି କାର ସହି ତ ଦାୟି ତ୍ୱ ମଧ୍ୟ ଥାଏ। ଏହି  କର୍ତ୍ତ ବ୍ୟଗୁ ଡ଼ି କ ଏକ ସୂ ଚି ତ,
ଦାୟି ତ୍ୱବାନ ଏବଂ ନୈ ତି କ ନାଗରି କ ସୃ ଷ୍ଟି  କରି ବା, ଗଣତନ୍ତ୍ରକୁ  ସୁ ଦୃ ଢ଼ ​​କରି ବା ଏବଂ ରାଷ୍ଟ୍ର ନି ର୍ମା ଣ ପାଇଁ  ମାର୍ଗ ଦର୍ଶ କ ନୀତି  ଭାବରେ କାର୍ଯ୍ୟ  କରେ। ସାମଗ୍ରି  କ ଭାବରେ, ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ଦେଶପ୍ରେ ମ,
ଶୃ ଙ୍ଖଳା, ସମ୍ମାନ ଏବଂ ସାମୂ ହି କ ଦାୟି ତ୍ୱକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରେ, ଯାହା ସେମାନଙ୍କୁ  ରାଷ୍ଟ୍ରର ସାମଗ୍ରି  କ ଅଭି ବୃ ଦ୍ଧି  ଏବଂ ସମନ୍ୱ ୟ ପାଇଁ  ଅତ୍ୟାବଶ୍ୟକ କରି ଥାଏ।

କେଉଁ  ସଂଶୋଧନ ଦ୍ଵାରା ସମ୍ବି ଧାନରେ ମୌଳି କ କର୍ତ୍ତ ବ୍ୟଗୁ ଡ଼ି କ ଯୋଡା ଯାଇଥି ଲା ?

A.  44ତମ ସଂଶୋଧନ

B.  42ତମ ସଂଶୋଧନ

C.  52ତମ ସଂଶୋଧନ

D.  86ତମ ସଂଶୋଧନ
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✓

Q67 Odia
କେଉଁ  ଭାଗରେ ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ଗୁ ଡ଼ି କ ତାଲି କାଭୁ କ୍ତ କରାଯାଇଛି ?

A.  ଭାଗ III

B.  ଭାଗ IV

C.  ଭାଗ IV-A

D.  ଭାଗ V

✓

Q68 Odia
କେଉଁ ଟି  ଏକାଦଶ କର୍ତ୍ତ ବ୍ୟ ସହି ତ ଜଡି ତ ?

A.  ପରି ବେଶ ସୁ ରକ୍ଷା

B.  ରାଷ୍ଟ୍ରର ସୁ ରକ୍ଷା

C.  ସମନ୍ୱ ୟ ପ୍ରୋ ତ୍ସାହନ

D.  ପି ଲାମାନଙ୍କୁ  ଶି କ୍ଷା ପ୍ର ଦାନ

✓

Q69 Odia
ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ଗୁ ଡ଼ି କ ହେଉଛି :

A.  ଆଇନ ଦ୍ୱାରା ପ୍ର ବର୍ତ୍ତ ନଯୋଗ୍ୟ

B.  ନ୍ୟାୟି କ ଅଧି କାର

C.  ଜରୁ ରୀକାଳୀନ ଅଧି କାର

D.  ଆଇନ ଦ୍ୱାରା ବି ଚାରଯୋଗ୍ୟ ନୁ ହେଁ

✓

Q70 Odia
କେଉଁ  ସଂସ୍ଥା ରୁ  ମୌଳି କ କର୍ତ୍ତ ବ୍ୟ ପାଇଁ  ସୁ ପାରି ଶ ଆସି ଥି ଲା ?

A.  ନେହେରୁ  କମି ଟି

B.  ସରକାରି ଆ କମି ଶନ

C.  ସ୍ୱରଣ ସିଂ ହ କମି ଟି

D.  ମଣ୍ଡଳ କମି ଶନ

✓

Q71 Odia
“ପ୍ରା ଚୀ” ର ବି ପରୀତ ଶବ୍ଦ ଦର୍ଶା ଅ ।

A.  ପ୍ର ଦୋଷ

B.  ସ୍ଵାଧୀନ

C.  ପ୍ର ତୀଚୀ

D.  ପ୍ରା ଚୀନ

✓

Q72 Odia
ଦର୍ଶ କମାନେ ନାଟକ ଦେଖି କି  ହସୁ ଛନ୍ତି  । ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  କ୍ରି  ୟାପଦ?

A.  ସମାପି କା କ୍ରି  ୟା

B.  ସକର୍ମ କ କ୍ରି  ୟା

C.  ଅସମାପି କା କ୍ରି  ୟା

D.  ଅକର୍ମ କ କ୍ରି  ୟା
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✓

Q73 Odia
ଦେଖନ୍ତୁ ଝରଣା ଝରଝର ହୋଇ ଝରୁ ଛି  । ଉକ୍ତ ବାକ୍ୟରେ କ୍ରି  ୟାବି ଶେଷଣ ଚି ହ୍ନଟ କର ।

A.  ଝରଣା

B.  ଝରଝର

C.  ଦେଖନ୍ତୁ

D.  ଝରୁ ଛି

✓

Q74 Odia
‘ଏଣ୍ଡୁଅ ପରି  ମୁ ଣ୍ଡ ଟୁ ଙ୍ଗାରି ବା’ – ଏହା କେଉଁ  ପ୍ର କାରର ରୂ ଢି ?

A.  କ୍ରି  ୟାଯୁ କ୍ତ ରୂ ଢି

B.  ତୁ ଳନାତ୍ମକ ରୂ ଢି

C.  କ୍ରି  ୟାହୀନ ରୂ ଢି

D.  ଉପମାଯୁ କ୍ତ ରୂ ଢି

✓

Q75 Odia
'ସମ୍ବୋଧନ ସୂ ଚକ ଅବ୍ୟୟ' କାହାକୁ  କୁ ହାଯାଏ ?

A.  ଯେଉଁ  ଅବ୍ୟୟ କାଳକୁ  ବୁ ଝାଏ

B.  ଯେଉଁ  ଅବ୍ୟୟ ସ୍ଥାନକୁ  ବୁ ଝାଏ

C.  ଯେଉଁ  ଅବ୍ୟୟ ପରି ମାଣକୁ  ବୁ ଝାଏ

D.  ଯେଉଁ  ଅବ୍ୟୟ ସମ୍ବୋଧନ କରି ବା ପାଇଁ  ବ୍ୟବହୃ ତ ହୁ ଏ

Computer

✓

Q76 Computer
If you are setting up a presentation and only want the audience to
see the slides, while you, the speaker, can secretly view your notes,
timers, and the next slide, which display option should you use?

A.  Presenter View

B.  Reading View

C.  Slide Sorter View

D.  Outline View

✓

Q77 Computer
How can you delete a slide from a PowerPoint presentation?

A.  Press Ctrl + D on the keyboard

B.  Go to the Insert tab and select Delete Slide

C.  Right-click the slide thumbnail and choose Delete Slide

D.  Click the File tab and select Remove Slide

✓

Q78 Computer
Which of the following correctly represents the basic structure of
an email message?

A.  Subject line → Greeting → Body → Closing → Signature

B.  Body → Subject line → Greeting → Signature

C.  Greeting → Signature → Subject line → Body

D.  Closing → Subject line → Body → Greeting

✓

Q79 Computer
Which MS PowerPoint option allows you to select between
“Presented by a speaker” or “Browsed by an individual” modes?

A.  Slide Show → Set Up Slide Show

B.  View → Slide Master

C.  Design → Page Setup

D.  Transitions → Timing ​​​​​
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✓

Q80 Computer
Application software is mainly designed to:

A.  Control hardware devices

B.  Manage system startup processes

C.  Convert programming code to machine language

D.  Perform specific tasks for users

✓

Q81 Computer
Which of the following best defines application software?

A.  Software that manages hardware resources

B.  Programs designed to perform tasks for end users

C.  Software built into the motherboard firmware

D.  Utilities that control booting operations

✓

Q82 Computer
How can we center the text in a paragraph in MS Word 2007?

A.  Ctrl + M

B.  Ctrl + E

C.  Ctrl + J

D.  Ctrl + C

✓

Q83 Computer
Which category of memory in a computer is volatile and disappears
when the computer is powered off?

A.  Flash Memory

B.  Read Only Memory

C.  Random Access Memory

D.  Secondary Memory

✓

Q84 Computer
Which of the following is a function of the Windows Task Manager?

A.  To display system performance information to the user

B.  To protect the computer against viruses

C.  To receive email notifications and send emails

D.  To search for files in the system

✓

Q85 Computer
What is the main purpose of the Print Preview feature in MS Word?

A.  To save the document automatically

B.  To preview how the document will appear when printed

C.  To check for grammar errors

D.  To share the document online

✓

Q86 Computer
In MS Word 2019, which of the following steps correctly inserts a
numbered list into a document?

A.  Go to Home tab > Font group > Numbering

B.  Go to Insert tab > Table group > Numbering

C.  Go to Home tab > Paragraph group > Numbering

D.  Go to Layout tab > Page Setup group > Numbering

✓

Q87 Computer
F2 key is used in MS excel to:

A.  edit the content of a cell

B.  view and copy the content of a cell

C.  delete the content of a cell

D.  view and cut the content of a cell

✓

Q88 Computer
What does the World Wide Web (WWW) primarily consist of?

A.  Email servers

B.  Trillions of interlinked web pages and web resources

C.  Software applications only

D.  Hardware devices used for networking
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✓

Q89 Computer
Which feature in Excel allows a user to generate a sequence like
Monday, Tuesday, Wednesday automatically by dragging the fill
handle?

A.  Flash Fill

B.  AutoFormat

C.  AutoFill

D.  Sort & Filter

✓

Q90 Computer
If you want to count logical values, text, or error values, use the
___________ function.

A.  COUNT

B.  COUNTIF

C.  COUNTA

D.  COUNTIFS

Reasoning

✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the wife of B’,
'A – B' means ‘A is the brother of B’,
'A x B' means ‘A is the mother of B’,
'A = B' means ‘A is the father of B’.

How is P related to Q if ‘P x R = Y – S + Q’?1954

A.  Wife's sister

B.  Mother

C.  Brother's wife's father's mother

D.  ​Wife's father's mother

✓

Q92 Reasoning
Anant, while playing scrabble, picked seven random letters; E, H, Q,
U, Z, J and P, and placed them in a row on a stand facing north. Q is
placed fourth from the extreme left end and has E and H as
immediate neighbours. H is placed immediate right of Q. P is placed
second from the extreme left end and is neither an immediate
neighbour of J nor U. U is not an immediate neighbour of H. What is
the position of U from the extreme left end?

A.  First

B.  Third

C.  Sixth

D.  Seventh

✓

Q93 Reasoning
Seven boxes I, J, K, L, W, X and Y are kept one over the other but not
necessarily in the same order. Only L is kept above W. Only I is kept
between W and X. Only K is kept below J. How many boxes are kept
between Y and K?

A.  One

B.  Two

C.  Three

D.  Four

✓

Q94 Reasoning
In the following triads, each group of letters is related to the
subsequent one following a certain logic. Select from the given
options, the one which follows the same logic.
RUST - UTSR - TSUR
UGLY - GYLU - YLGU

A.  CONE - OENC - ENOC

B.  DINE - DNIE - ENID

C.  SHIP - HSIP - PHIS

D.  FAST - AFST - TASF
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✓

Q95 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 3785614, what will be the sum of the digits
which are second from the left and third from the right in the new
number thus formed?

A.  12

B.  8

C.  10

D.  6

✓

Q96 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?

HDE JGD LJC ? PPA

A.  MNO

B.  BHG

C.  NMB

D.  YGT

✓

Q97 Reasoning
In a certain code language, 'VYGN' is coded as '31' and 'PEXI' is
coded as '45'.
What is the code for 'QGRB' in the given code language?

A.  55

B.  52

C.  48

D.  47

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: Some batteries are torches. All clocks are torches.
Conclusion (I): Some batteries are clocks.
Conclusion (II): All torches are clocks.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter-clusters are alike in a certain way and thus form a group.
Which letter-cluster DOES NOT belong to that group? (Note: The odd
one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)
748

A.  RTO

B.  PRM

C.  JNG

D.  TVQ

✓

Q100 Reasoning
Each letter in the word SYNCHED is changed to the letter
immediately following it in the English alphabetical order and then
all the letters thus formed are arranged in alphabetical order. Which
of the following letters will be fourth from the right in the new
group of letters thus formed? 7136

A.  E

B.  F

C.  I

D.  O
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